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ArcGIS Desktop is a suite of integrated applications including 
ArcMap, ArcCatalog, ArcToolbox, ModelBuilder, and ArcGlobe.
It is used to create, import, edit, query, map, analyze, and 
publish geographic information.

Introduction

This tutorial is intended to introduce you to the basic use of 
ArcGIS 9.1. We will concentrate on ArcMAP and ArcCatalog that 
describer some of the common operations a user may need to 
know in order to manipulate and/or analyze their spatial datasets.



Topics

Getting Started with ArcGIS
Displaying Map
Querying Data
Analyzing Spatial Data
Making and Printing Maps



Getting Started with ArcGIS

Applications of ArcGIS: ArcCatalog and ArcMap

ArcCatalog™ allows the user to easily access and manage geographic 
data that is stored in folders on local disks or relational databases that are 
available on the user's network.  Data can be copied, moved, deleted, and 
quickly viewed before it is added to a map.  In addition, metadata can be 
either read or created using this ArcGIS application.

ArcMap allows the user to display and query maps, create quality 
hardcopy maps and perform many spatial analysis tasks. ArcMap provides 
an easy transition from viewing a map to editing its spatial features.



Viewing Data in ArcCatalog –(1)

The ArcCatalog application window includes the catalog display that allows 
you to preview data, either spatially or tabularly, a catalog tree for 
browsing the data, and several toolbars. 

Toolsbar

Zoom In
Zoom Out
Pan
Full Extent
Identify
Create Thumbnail



Viewing Data in ArcCatalog –(2)

preview the attributes by switching to Table



Viewing Data in ArcCatalog –(3)

In addition to previewing the 
geography and the attribute 
table of a data layer, the 
user can view or create 
metadata. By clicking on the 
Metadata tab in the catalog 
display, technical 
information about the data 
set (such as its coordinate 
system, its spatial extent, 
description of its attributes, 
and descriptive information 
about when and how the 
data was created) can be 
obtained. 



Viewing Data in ArcMap – Add map(1)

There are two ways to add data layers to the map display: 

1. Go to File / Add Data... on the main menu toolbar OR click on
the Add Data button on the standard toolbar. 

Navigate to the data layer of interest. 
Select it, and click the Add button. 



Viewing Data in ArcMap – Add map(2)

2. Simply click the name of the data layer from the ArcCatalog data 
tree, and drag it anywhere within the ArcMap display. 



Viewing Data in ArcMap – ToolsBar



Viewing Data in ArcMap – View Attribute



Viewing Data in ArcMap – Statistics

Various statistics can be computed for 
a particular attribute field. To perform 
this operation the user should right click 
on the field of interest, and select 
statistics.
A dialog box appears with the statistics 
for that selected field. The statistics 
box displays the number of records in 
the table and the minimum, maximum, 
sum, mean, and standard deviation 
values. The frequency distribution 
chart represents the distribution of 
values graphically.



Displaying Map

Symbolizing Features (1)
To change the color or width of 
the outline, the user can click on 
the symbol for the desired data 
layer in the table of contents. The 
Symbol Selector dialog box 
opens. The left side of the dialog 
box contains predefined 
symbols. The options frame on 
the right allows the user to select 
a color and set an outline width. 



Symbolizing Features(2)

The user can also have 
features within the map 
display to be labeled. The 
user can do this by right-
clicking on the LAYER of 
interest in the table of 
contents (NOTE: click on the 
layer name and NOT the 
symbol) and selecting the 
Label Features option. 



The user may also change 
the background of the map 
display. This can be done 
by right-clicking on the data 
frame and clicking 
Properties. The Data 
Frame Properties dialog 
box opens. The user should 
click on the Frame Tab, 
click on the Background
drop down arrow, select the 
desired color, and click 
OK. The background color 
will then be applied to the 
map display. 

Symbolizing Features(3)



The user can change a feature's symbology to make it more informative by assigning a 
different symbol to each unique value, or to distinct ranges of values, in the layer's 
attribute table. 
If the user wishes to assign a unique color to a particular class or name within the 
attribute table, the user can right-click on the desired layer and click Properties. The 
Layer Properties dialog will open, and the user should choose the symbology tab. 

Symbolizing Features(4)

By default, the features 
are symbolized with a 
single symbol (meaning all 
of the prefectures in a 
Japan map will have the 
same color). If the user 
wishes to change the 
representation to a 
categorical one (where 
each prefectures has a 
unique symbol), the user 
should click Categories in 
the Show box of the 
Layer Properties Dialog. 



Symbolizing Features(5)

A Value Field from the attribute table should be 
selected. In this case PREF was selected in order 
to show a different symbol for each state. The 
color scheme of choice may also be 
selected. Once these parameters are set, the user 
should press the Add All Values button to get a 
listing of all the categories and their associated 
unique symbol. Once the user is satisfied with the 
symbology, the user can press OK. 



Classifying Features

ArcGIS™ has four ways to apply scaled symbology:
Graduated Color
These symbols are more commonly used. It displays features as shades in a 

range of colors that change gradually (also called a color ramp). This symbology
is best used with polygon layers.

Graduated Symbol
These symbols are used to represent features using different marker 

sizes. Normally used with point layers.

Proportional Symbol
These symbols vary in size proportionally to the value symbolized.

Dot Density
These symbols should only be used with polygon layers. They represent 

quantities by a random pattern of dots. The greater the value, the more dots.



Creating Graduated Color Map (1)

To create a graduated color, 
the user must double click on 
the data layer name in the 
table of contents. The Layer 
Properties dialog will 
open. The symbology tab 
should be activated.
In the show box, the user 
should click Quantities and 
select the Graduated Colors
option. Within the value field, 
the drop down arrow should 
be clicked, and the attribute 
field of interest should be 
selected. In this case the 
Population field was selected 
for the Japan data layer.



Creating Graduated Color Map (2)



Creating Graduated Symbol Map (1)

To create a graduated 
symbol, the user must double 
click on the data layer of 
interest in the table of 
contents. The Layer 
Properties dialog box will 
open, and the symbology tab 
should be selected. In the 
show box, the user should 
click Quantities, and then 
select Graduated 
Symbols. Within the value 
field, the drop down arrow 
should be clicked, and the 
attribute field of interest 
should be selected. The 
normalization method and the 
number of classes can then 
be selected.



Creating Graduated Symbol Map (2)



Creating Proportional Symbol Map (1)

To create a proportional 
symbol, the user must double 
click on the data layer of 
interest in the table of 
contents. The Layer 
Properties dialog box will 
open, and the symbology tab 
should be selected. In the 
show box, the user should 
click Quantities, and then 
select Proportional Symbols.



Creating Proportional Symbol Map (2)



Creating Dot Density Map (1)

To create a dot density, the 
user must double click on the 
data layer of interest in the 
table of contents. The Layer 
Properties dialog box will 
open, and the symbology tab 
should be selected.
In the show box, the user 
should click Quantities, and 
then select Dot Density.



Creating Dot Density Map (2)



Querying Data

Identifying Features

To use the Identify tool, the 
user must select it from the 
Tools Toolbar. Within the map, 
the user must click on the 
feature of interest in order to 
view the attribute information 
for that particular feature.



Selecting Features (1)

1

2

3 1.Click on Select Features Tool

2. Hold Shift Key and select 
features of interest

3. Open Attribute Table



Selecting Features (2)



Finding Features

The user can find a feature, by 
selecting the Find tool on the 
Tools toolbar. When the Find
dialog Box appears, the 
Features tab should be 
selected. The known attribute 
information should be typed in 
the Find box. In the In Layers
drop down box, the layer that 
the user wishes to find 
features in should be 
selected. In the Search
options, the user should 
choose to either search all 
fields in the attribute table or a 
specific field. Once all 
parameters are set, the Find
button should be clicked.



Selecting Features by Attributes

To create an attribute query, the 
user must click the Selection
menu on the Standard 
Toolbar. The Select by 
Attributes option should be 
clicked. In the Select by 
Attributes dialog box, the 
Layer drop down arrow should 
be clicked and the data layer of 
interest should be selected.



Selecting Features by Location

To begin selecting features by 
location, the user must click the 
Selection menu and click the 
Select by Location option. The 
Select by Location dialog box 
opens.



Analyzing Spatial Data

To use the ArcToolbox Buffer tool, the 
user must go to Analysis Tools and 
select Proximity. Buffer then appears 
in the list of tools. 

Buffering Features (1)



Buffering Features (2)

A double click on Buffer results in 
the appearance of the Buffer 
dialog box. The drop down arrow 
should be clicked, or the browse 
button used, to select the layer 
the user wishes to buffer. Then, 
the Linear unit radio button 
should be clicked and units and 
distance specified. If the user 
wishes to dissolve the barriers 
between any overlapping buffers 
he or she may do so by selecting 
LIST from the drop-down menu 
within Dissolve Type. Once the 
list of attribute fields appears with 
a white background the box next 
to Shape should be checked. 



Buffering Features (3)



Overlay Features

An overlay operation is also one of the most common spatial analysis tools. Overlays allow 
the user to identify areas where features in two layers overlap. A new data set is often 
created from these overlaps. In a Union Overlay, all features are included in the new data 
set but the features that overlap represent a new feature. In an intersect overlay, only the 
areas that overlap are contained in the new data set. 



Overlay Features – Union (1)

The union overlay option may be very 
useful if the user wishes to combine data 
layers into one layer.
To perform a union overlay, the user must 
go to ArcToolbox's Analysis Tools, select 
Overlay, and then click Union. The user 
then specifies the input layers to union 
and a name for the output data set.



Union

Overlay Features – Union (2)



Overlay Features – Intersect (1)



Intersect

Overlay Features – Intersect (2)



Making and Printing Maps(1)

If the data is already present 
within the data view, the user 
simply needs to switch to 
Layout View and select the
Map Template button on the 
Template Toolbar.



Making and Printing Maps(2)

The map background color may be 
changed by selecting the data 
frame and clicking the down arrow 
next to the Fill Color button on the 
Draw Toolbar. When the user 
selects a desired color, the map 
background color will be updated.



A map title may be added to the layout 
by clicking the Insert menu and 
selecting the Title option. A text box 
will be added to the page. Within this 
text box, a default title will be present. 
The user can type in a preferred title 
within the text box and press Enter. 
After the Enter key has been pressed, 
the user can go back and edit the title 
by double-clicking the on the title and 
editing its text properties.  

The font, size, style, or color of the 
title may be changed using the Draw 
Toolbar. 

Making and Printing Maps(3)



A North Arrow may be added by 
clicking the Insert menu and 
selecting the North Arrow
option. In the North Arrow Selector
dialog box that appears, the user 
may select from a variety of north 
arrows and change the properties 
of any selected arrow. 

Making and Printing Maps(4)



A Scale Bar may be added by 
clicking the Insert menu and 
selecting the Scale Bar option. The 
desired scale bar style may be 
chosen and its properties my be 
edited within the Scale Bar Selector 
dialog box. 

Making and Printing Maps(5)



A Legend may be added 
by clicking the Insert
menu and selecting the 
Legend option. 

Making and Printing Maps(6)



Making and Printing Maps(7)

The user needs to make sure that the 
map size is the same as the printer page 
size. Once all parameters have been 
chosen, the OK button should be clicked.
Before printing the map, the user should 
always preview their map. This can be 
done by clicking the File menu and 
selecting Print Preview. This allows the 
user to see if anything needs to be 
changed before the map is printed.
If changes need to be made, the Print 
Preview should be closed (by clicking 
the Close button), and the appropriate 
changes should be made. If everything 
appears the way that it should, the user 
may click the Print button. Appropriate 
print parameters must be set, and the 
OK button should be clicked when the 
user is ready to print the map.
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